
 

SimMechanics Release Notes

The “SimMechanics 2.3 Release Notes” on page 1-1 describe the changes in 
this product since Version 2.2.2. The following topics are discussed in these 
Release Notes.

• “New Features” on page 1-2

• “Major Bug Fixes” on page 1-4

• “Upgrading from an Earlier Release” on page 1-5

• “Known Software and Documentation Limitations” on page 1-6

If you are upgrading from a version earlier than Version 2.2.2, you should 
also see:

• “SimMechanics 2.2.2 Release Notes” on page 2-1

• “SimMechanics 2.2.1 Release Notes” on page 3-1

• “SimMechanics 2.2 Release Notes” on page 4-1

• “SimMechanics 2.1.1 Release Notes” on page 5-1

• “SimMechanics 2.1 Release Notes” on page 6-1

• “SimMechanics 2.0.1 Release Notes” on page 7-1

• “SimMechanics 2.0 Release Notes” on page 8-1

Printing the Release Notes
If you would like to print the Release Notes, you can link to a PDF version.
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New Features

New Shared Environment Block
The new Shared Environment block allows you to link two separate 
SimMechanics block diagrams with a nonphysical connection. The block 
enforces the same machine environment settings on both machines but adds no 
mechanical components (bodies or degrees of freedom) to either. Two machines 
so connected require exactly one Machine Environment block, rather than two.

See the Shared Environment block reference for further details.

Updated Body Spring & Damper Block
The Body Spring & Damper block no longer contains any degrees of freedom.

New State Vector Commands
SimMechanics features four new commands that allow you to manipulate the 
mechanical states of your models. See the command references for more.

• mech_get_states
• mech_runtime_states
• mech_set_states
• mech_transfer_states

New import_physmod Dialog
The import_physmod command generates SimMechanics models from Physical 
Modeling XML files. In addition to importing Physical Modeling XML through 
the command line, you can now set up the command through a dialog.

See the import_physmod command reference for further information.

Demos Expanded
Two new demos have been added to SimMechanics:

• mech_flexible_four_bar models a flexible four bar machine.

• mech_pole_vault models a rigid pole vaulter, with a discrete event.

The second demo has an associated MAT-file.
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Documentation Enhancements
The SimMechanics User’s Guide has been enhanced.

• The review chapter on represeting motion has been revised.

• The motion analysis chapter has been revised.

• The computer-aided design (CAD) documentation (also available as a 
separate book) has been significantly revised. See the CAD chapter.

• A new chapter of case studies, based on the Stewart platform, has been 
added. The studies apply advanced methods and tasks to this system. 
SimMechanics includes a related set of demo model and library files.

- Degrees of freedom, states, closed topology, and constraints

- Trimming and linearization

- Designing controllers for the platform

- Generating code versions of the model

- Implementing code on dedicated hardware (hardware in the loop)
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Major Bug Fixes
To view major bug fixes made since R14SP2 for SimMechanics, use the Bug 
Reports interface on the MathWorks Web site.

Note  If you are not already logged in to Access Login, when you link to the 
Bug Reports interface (see below), you will be prompted to log in or create an 
Access Login account.

After you are logged in, use this Bug Reports link. You will see the bug report 
for SimMechanics. The report is sorted with fixed bugs listed first, and then 
open bugs.

If you are viewing these release notes in PDF form on the MathWorks Web site, 
you can refer to the HTML form of the release notes on the MathWorks Web 
site and use the link provided.

For bug fixes added prior to Release 14SP2, see “Major Bug Fixes” in the 
SimMechanics Version 2.1.1 release notes.

http://www.mathworks.com/support/bugreports/index.html?product=MS&amp;release=R14SP3
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Upgrading from an Earlier Release
SimMechanics 2.3 presents several important issues if you are upgrading from 
a previous version.

Normalizing Rotations
The Body dialog accepts various rotational forms (Euler angles, rotation 
matrix, quaternion). SimMechanics now interprets these rotational forms in a 
slightly different way, so that the standard normalization conditions on 
rotation matrices and quaternions are consistently enforced. As a result, you 
might now see slightly different simulation results from earlier versions.

Updated Body Spring & Damper Block
Previous versions of the Body Spring & Damper block contained six degrees of 
freedom (DoFs) represented by a Joint. This Joint had to be taken into account 
when counting DoFs and loops in your model.

The new Body Spring & Damper block instead uses a Shared Environment 
block to connect the two sides and contains no DoFs. See their respective block 
references for more information.
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Known Software and Documentation Limitations
To view important open bugs in R14SP3 for SimMechanics Version 2.3, use the 
Bug Reports interface on the MathWorks Web site.

Note  If you are not already logged in to Access Login, when you link to the 
Bug Reports interface (see below), you will be prompted to log in or create an 
Access Login account.

After you are logged in, use this Bug Reports link. You will see the bug report 
for SimMechanics. The report is sorted with fixed bugs listed first, and then 
open bugs.

If you are viewing these release notes in PDF form on the MathWorks Web site, 
you can refer to the HTML form of the release notes on the MathWorks Web 
site and use the link provided.

SolidWorks Compatibility for CAD Translator
The SimMechanics computer-aided design (CAD) translator for SolidWorks 
works with SolidWorks 2004 and SolidWorks 2005 SP0 and SP2. The 
translator is no longer compatible with earlier versions of SolidWorks.

An older version of the CAD translator is available via the MathWorks Web 
site. This version supports SolidWorks 2001Plus and 2003.

Uninstalling and Reinstalling the CAD Translator
If you remove the CAD translator for SolidWorks and want to reinstall it, you 
must reboot your system first after uninstalling. Then you can reinstall the 
translator.

SolidWorks CAD Platform Limitations
The SolidWorks CAD platform and the SimMechanics CAD translator for 
SolidWorks are available only for the Microsoft Windows operating system.

http://www.mathworks.com/support/bugreports/index.html?product=MS&amp;release=R14SP3
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New Features

Demos Expanded
Two new demos have been added to SimMechanics:

• mech_sticky_box
• mech_sticky_screw

Each demo has an associated MAT-file.

These demos illustrate static friction (stiction) implemented with the Joint 
Stiction Actuator.

Documentation Enhancements
The online SimMechanics Help has been enhanced with links to four new 
Web-based AVI animation files (one of them new in this release) that record 
SimMechanics simulations.

You can access these links most easily by using the Examples index in the Help 
browser, under Prerecorded Animations.
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New Features

Demos Updated and Expanded
The demos used in the open-topology Inverse Dynamics case study have been 
changed:

• mech_dpend_invdyn1
• mech_dpend_invdyn2

• mech_dpend_act (a new demo replacing mech_dpend_stat)

The last, new demo has an associated MAT-file, mech_dpend_act.mat. See 
“Documentation Enhancements” following.

Two other new SimMechanics demos have been added:

• mech_cambelt models a cam, belt, and pulley system with a Point-Curve 
Constraint block.

• mech_viscous illustrates how to model a viscous medium with a Joint 
Spring-Damper block.

Documentation Enhancements
The online SimMechanics Help has been enhanced with additional multimedia 
support.

• The online Help contains four detailed mechanical drawings for systems 
modeled in the user’s guide: the conveyor, the four bar machine, and the 
Stewart platform.

• The online Help also contains links to three new Web-based AVI animation 
files that record SimMechanics simulations.

You can access these features most easily by using the Examples index in the 
Help browser, under Mechanical Drawings and Prerecorded Animations, 
respectively.

The open-topology Inverse Dynamics section of the motion analysis chapter has 
been enhanced with a new, more complex and more realistic example. The 
related demos have been changed as well; see “Demos Updated and Expanded” 
previously.
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Major Bug Fixes
SimMechanics 2.2.1 includes these important bug fixes made since Version 2.2.

If you are viewing these Release Notes in PDF form, refer to the HTML form of 
the Release Notes, using either the Help browser or the MathWorks Web site, 
and use the link provided.
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New Features

Simulation and Visualization Controls Changes
This version of SimMechanics introduces significant changes to how you 
control simulation, mechanical environment, and visualization in 
SimMechanics models. These changes, summarized below, include

• New Machine Environment Block

• Choosing a Ground Block as Machine Root

• Optional Two-Dimensional Solver

• Optional Gravity Signal

• New SimMechanics Diagnostics Settings

• Visualization Controls Relocated

• Manual Updating of Body Visualization

The new controls are fully documented in the SimMechanics User’s Guide 
chapters on running simulations and visualization.

New Machine Environment Block
In the new version of SimMechanics, you configure the mechanical 
environment for an entire model in the SimMechanics node of the 
Configuration Parameters dialog, accessed via the Simulation menu. You 
configure the mechanical environment for each separate machine diagram (one 
or more per model) via its Machine Environment block. These two dialogs 
replace the old Mechanical Environment Settings dialog.

You must connect exactly one Machine Environment block to each separate 
machine diagram at one of the machine’s Ground blocks. The new Machine 
Environment block is located in the Bodies library.

See “Choosing a Ground Block as Machine Root” following. See also “Updating 
Mechanical Environment Settings.”

Choosing a Ground Block as Machine Root
The new Ground block has the option of being chosen as the root for a machine’s 
Machine Environment block. In each separate machine diagram (one or more 
per model), choose one such Ground by selecting Show Mechanical 
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Environment port in its dialog. A special port appears on the Ground. Then 
connect a Machine Environment block to the Ground at this port.

See “New Machine Environment Block” preceding.

Optional Two-Dimensional Solver
The new Machine Environment block allows you to choose, through its 
Machine dimensionality pull-down menu, a specialized solver for a machine 
that moves in only two dimensions. SimMechanics detects the dimensionality 
and automatically adjusts the solver by default. But you can override the 
default and require SimMechanics to work in either three or two dimensions.

The two-dimensional solver significantly improves simulation performance in 
two and one dimensions.

Optional Gravity Signal
The new Machine Environment block allows you to input gravity as an external 
Simulink® signal. In the block dialog, select Input gravity as signal. A 
Simulink inport appears for connecting the Simulink signal line. The gravity 
must be a three-component vector signal. You choose the units in the Gravity 
vector units pull-down menu of the block dialog. SimMechanics interprets the 
vector gravity signal the same way it interprets the static Gravity vector field 
value in the block dialog.

If you choose gravity as a signal, the Gravity vector field is ignored.

New SimMechanics Diagnostics Settings
SimMechanics now lets you control diagnostic messages. In the SimMechanics 
node of the Configuration Parameters dialog, accessed via the Simulation 
menu, you can select to enable or disable certain warning messages, and 
whether to mark closed-loop joints cut automatically by SimMechanics.
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Restricted Body Coordinate System References
All coordinate system (CS) references in Body blocks from one CS to another 
CS must now refer only to

• Other CSs on the same Body

• Adjoining CSs (coordinate systems on Bodies directly connected to the 
referring body)

• World

All other CS references now cause simulation errors.

See also “Major Bug Fixes,” and “Restricting Body Coordinate System 
References” under “Upgrading from an Earlier Release.”

Minimum Number of Body Coordinate Systems
You can no longer eliminate all the non-center-of-gravity (CG) Body coordinate 
systems (CSs) on a Body block dialog. Besides the undeletable CG CS entry, at 
least one non-CG CS must remain. See also “Major Bug Fixes.”

Visualization Controls Relocated
You now enable SimMechanics visualization and animation for an entire model 
in the Visualization area of the SimMechanics node of the Configuration 
Parameters dialog, reached via the Simulation menu. You now enable or 
disable visualization for individual machines within a model via the 
Visualization pane of the Machine Environment block dialog. See “New 
Machine Environment Block” preceding.

All SimMechanics visualization controls are now located on the MATLAB® 
Graphics visualization window, in the special SimMechanics menu and 
toolbar.

Manual Updating of Body Visualization
SimMechanics visualization no longer immediately displays a Body newly 
added to a model. Instead you must update the model by selecting Update 
Diagram from the Edit menu.
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Code Generation with Point-Curve Constraint Now 
Enabled
The Point-Curve Constraint no longer creates algebraic loops in Simulink. This 
improvement means that you can now generate code from models containing 
Point-Curve Constraints.

Code Generation Improvements
The stand-alone SimMechanics library used for code generation is now 
precompiled for supported platforms using standard targets. This feature 
significantly speeds up compilation of generated code.

SimMechanics code generation now supports the Real-Time Windows Target.

Additional Simulink Features Now Supported
SimMechanics now supports Model Referencing and S-function target. It also 
now supports Simulink External mode, but without visualization. See the 
sections on generating code and SimMechanics limitations in the 
SimMechanics documentation.

SimMechanics Now Supported on HP-UX Platforms
SimMechanics is now supported on the Hewlett-Packard UNIX (HP-UX) 
operating system.

Demos Updated and Expanded
All SimMechanics demos have been updated with the new Machine 
Environment block. New demos have also been added:

• mech_bouncing_ball demonstrates how to model impact and collisional 
forces using a bouncing ball.

• mech_flyball models a flyball governor mechanism.

• mech_rack_pinion models a driven rack-and-pinion mechanism.

• mech_rolling_sphere demonstrates how to model nonholonomic constraints 
using a sphere rolling on a two-dimensional surface.

• mech_toroid illustrates the Point-Curve Constraint with a body sliding on a 
toroidal curve.
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Documentation Enhancements
The SimMechanics user’s guide has been enhanced.

• The review chapter on body motion and coordinate systems is expanded with 
greater detail and more examples.

• The computer-aided design (CAD) documentation (also available as a 
separate book) has been significantly revised and expanded. See the CAD 
chapter.

• The case study sections on trimming and linearization have been revised and 
expanded, including a new closed-loop linearization example.

You can find a more complex closed-loop linearization example using a Stewart 
platform model at

www.mathworks.com/company/newsletters/digest/sept02/stewart.html

http://www.mathworks.com/company/newsletters/digest/sept02/stewart.html
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Major Bug Fixes
SimMechanics 2.2 includes these important bug fixes made since Version 2.1.1.

If you are viewing these Release Notes in PDF form, refer to the HTML form of 
the Release Notes, using either the Help browser or the MathWorks Web site, 
and use the link provided.

http://www.mathworks.com/company/newsletters/digest/sept02/stewart.html
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Upgrading from an Earlier Release
SimMechanics 2.2 presents several important issues if you are upgrading from 
a previous version.

Updating Mechanical Environment Settings
Prior to Version 2.2, SimMechanics models recorded mechanical environment 
data in the Mechanical Environment Settings dialog. Although you can no 
longer access this dialog from the Simulation menu, you can continue to run 
old models as they are. If you want to view these old settings, enter 
mech_environment(gcs) at the command line with your old model open. You 
cannot change the dialog settings.

If you want to change the settings in old models or build a new SimMechanics 
model, you must use the new Machine Environment block. Copying this block 
from the Bodies library into an old model causes the old Mechanical 
Environment Settings data to be copied into the block. You can then 
reconfigure the new block as you want.

See “New Machine Environment Block” and “Choosing a Ground Block as 
Machine Root” under “New Features.”

Restricting Body Coordinate System References
All coordinate system (CS) references in Body blocks to CSs must now refer 
only to other CSs on the same Body, to Adjoining CSs (coordinate systems on 
bodies directly connected to the referring body), or to World.

Other types of CS references from one Body to another now lead to simulation 
errors. If any of your old models contain such references, you must update 
them.

Internal Virtual Reality Visualization No Longer 
Supported
SimMechanics no longer includes internally integrated Virtual Reality Toolbox 
visualization. Models configured to use virtual reality now default to the 
MATLAB Graphics visualization/animation tool, which is still supported by 
SimMechanics.
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You can continue to use Virtual Reality Toolbox with SimMechanics by 
creating your own virtual world for your machine, incorporating into your 
model a VR Sink block linked to your virtual world, and feeding Body Sensor 
signals to the VR Sink.

See the virtual reality section of the visualization sections in the SimMechanics 
documentation.

Consult the Web product page for more about Virtual Reality Toolbox.

http://www.mathworks.com/products/virtualreality/
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Major Bug Fixes
SimMechanics 2.1.1 includes the following bug fix.

Model Reinitialization After Simulation Errors
Restarting a model that had encountered an error during a previous simulation 
sometimes led SimMechanics to return warnings and zero results. Starting the 
model a third time reproduced the errors of the first simulation. This bug is 
now fixed.
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New Features
Two important features have been introduced in SimMechanics 2.1 since 
Version 2.0.1.

Computer-Aided Design Translator for SolidWorks
SimMechanics 2.1 contains a standalone computer-aided design (CAD) 
translator for the SolidWorks® CAD platform. You install and use the CAD 
translator with SolidWorks but independently of MATLAB.

The translator converts a SolidWorks CAD machine assembly into an XML file 
in a special Physical Modeling format. The XML file represents the assembly 
in a form that you can use with SimMechanics to generate a block diagram 
model dynamically equivalent to the original CAD assembly. To generate 
models, use the new import_physmod command. See “import_physmod 
Command for Generating Models” below.

Relative to the main directory of your SolidWorks installation, the CAD 
translator installs to Applications/TheMathWorks/SimMechanics/.

import_physmod Command for Generating Models
Using the CAD translator (see above), you export a CAD assembly into an XML 
file in the Physical Modeling format.

This XML file represents the assembly in a form that you can use to generate 
a SimMechanics block diagram model dynamically equivalent to the original 
CAD assembly. You generate the model from the XML file with the 
import_physmod command.

The generated model contains Bodies and Joints that represent the original 
parts and degrees of freedom of the assembly. You can edit the generated model 
to add additional SimMechanics and Simulink blocks.

Special Documentation and Examples for CAD 
Translator
Special help files accompany the CAD translator. They include two HTML 
pages and a special PDF book.
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These files are independent of the MATLAB help system. Relative to the main 
directory of your SolidWorks installation, the special CAD translator 
documentation installs to Applications/TheMathWorks/SimMechanics/help/.

The SimMechanics User’s Guide has not been updated for this release.

Some examples of SolidWorks CAD assemblies are installed to Applications/
TheMathWorks/SimMechanics/examples/. One of the examples is a robot arm 
assembly. The corresponding XML file in Physical Modeling format, 
robot.xml, is located in the toolbox/physmod/mech/mechdemos directory, 
relative to your MATLAB root.
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Major Bug Fixes
SimMechanics 2.1 includes these important bug fixes made since Version 2.0.1.

If you are viewing these Release Notes in PDF form, please refer to the HTML 
form of the Release Notes, using either the Help browser or the MathWorks 
Web site, and use the link provided.
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Upgrading from an Earlier Release
This section presents issues involved in upgrading from SimMechanics 2.0 to 
SimMechanics 2.1.

Installing the CAD Translator for SolidWorks
The computer-aided design (CAD) translator for SolidWorks is independent of 
MATLAB. You must install it separately, then interface it with SolidWorks.

Installing
You can obtain the self-extracting executable archive 
SimMechanics_Translator_for_SolidWorks.exe in two ways.

• When you install SimMechanics 2.1, the archive is installed to toolbox/
physmod/import/standalone/solidworks/win32/, relative to your 
MATLAB root.

• Alternatively, you can download the archive independently of MATLAB at 
www.mathworks.com/products/simmechanics/.

Once you have the archive, run it. Click Setup.

The setup utility searches your hard drive for the SolidWorks installation 
location. If you wish to specify the location yourself, you can interrupt the 
search at any time by pressing the spacebar and then entering a full or partial 
path to your SolidWorks directory. Once the installer finds SolidWorks, it 
prompts you to confirm. After you confirm, the installation runs to completion.

A README file, with additional instructions, appears after installation.

Linking to SolidWorks
After you have completed the preceding steps to install the translator, start 
SolidWorks.

Choose Add-Ins from the Tools menu. Then select SimMechanics.

http://www.mathworks.com/products/simmechanics
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Major Bug Fixes
SimMechanics 2.0.1 includes the following bug fix.

Code Compilation with lcc Compiler
Attempting to compile code generated from SimMechanics models using lcc led 
to errors in Version 2.0. This bug is now fixed.
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New Features
A number of important features have been introduced in SimMechanics 2.0 
since Version 1.1 (Release 13). This section summarizes them.

Code Generation with Real-Time Workshop
You can now generate stand-alone C code from SimMechanics models using 
Real-Time Workshop®. You can also export it to a PC kernel using xPC Target.

SimMechanics 2.0 requires Real-Time Workshop 5.0.1 or later to generate code 
for the Rapid Simulation (RSIM) target.

Accelerator Mode and Discrete Events
Accelerator mode now supports discrete events associated with the Joint 
Stiction Actuator and the Point-Curve Constraint.

Expanded Handle Graphics Visualization Features
The MATLAB Graphics visualization tool of SimMechanics has a large number 
of new features, including recording and playback of simulation animations.

Variable Body Mass and Inertia Tensor
The Sensors & Actuators library features a new Variable Mass & Inertia 
Actuator block. This block accepts Simulink signals that vary the mass and/or 
inertia tensor of the Body block to which it is connected. The block only 
simulates the changes in the body’s mass properties and does not simulate the 
effect of the thrust forces or torques resulting from the accretion or ejection of 
mass.

Vectorized Joint Initial Condition Actuation
The Joint Initial Condition Actuator block now lists all the primitives in the 
Joint block to which it is connected. You can set initial positions/angles and 
initial velocities separately for each prismatic and revolute primitive.

Damped Linear Force Element Blocks
This release introduces a new block library, Force Elements, with two blocks 
representing damped linear harmonic oscillator forces. The Body 

http://www.mathworks.com/access/helpdesk/help/toolbox/rtw/rtw.shtml
http://www.mathworks.com/access/helpdesk/help/toolbox/xpc/xpc.shtml
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Spring-Damper block simulates a damped spring-like force between two 
bodies. The Joint Spring-Damper block actuates a joint primitive with a 
damped spring-like force or torque.

New Mechanical Branching Bar Block
The Utilities library features the new Mechanical Branching Bar block. You 
can use this block to map multiple sensor and actuator lines to one sensor/
actuator port on a Joint, Constraint, or Driver or to one Body coordinate system 
on a Body.
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Major Bug Fixes
SimMechanics 2.0 includes these important bug fixes made since Version 1.1 
(Release 13).
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